
【一、P 话题】

Colours
Bright → Lively 生动的 / Vivid 鲜明的

Dark → Dim 昏暗的 / Gloomy 阴暗的

Light → Pale 苍白的 / Soft 柔和的

Vibrant → Radiant 光彩照人的 / Animated 生机勃勃的

Dull → Drab 单调的 / Lackluster 无光泽的

Stories
Story → Tale 故事 / Narrative 叙事

Read → Peruse 略读的 / Scan 浏览的

Write → Compose 创作的 / Pen 写作的

Listen → Hear 听见的 / Attend 留心听的

Imagination → Fantasy 幻想的 / Creativity 创意的

Borrowing/Lending
Borrow → Take 借用的 / Obtain 获得的

Lend → Loan 出借的 / Offer 提供的

Return → Give back 归还的 / Restore 还回的

【二、P 话题】

精力充沛的人

Energetic → Lively 生气勃勃的 / Vigorous 精力充沛的

Active → Busy 忙碌的 / Alert 警觉的

Cheerful → Happy 快乐的 / Joyful 欢快的

近期日常改变

Change → Alter 改变 / Modify 修改

Routine → Schedule 日程 / Habit 习惯

Improve → Enhance 提升 / Upgrade 升级

Daily → Everyday 日常的 / Regular 常规的

Adjust → Adapt 调整 / Tweak 微调

祖父/母的工作

Job → Work 工作 / Occupation 职业

Earn → Make money 赚钱 / Generate 产生

Retire → Step down 退休 / Withdraw 退出

感兴趣的科学学科

Science → Study 学科 / Discipline 领域

Experiment → Test 测试 / Trial 尝试



Research → Study 研究 / Inquiry 调查

Subject → Field 领域 / Area 范围

Learn → Study 学习 / Acquire 获得

想去的外国

Country → Nation 国家 / Land 国土

Visit → Travel 访问 / Tour 游览

Abroad → Overseas 海外的 / Foreign 异国的

Destination → Place 目的地 / Spot 地点

Explore → Discover 探索 / Venture 冒险

交通工具抛锚

Vehicle → Car 车辆 / Transport 交通工具

Break down → Fail 故障 / Malfunction 失灵

Repair → Fix 修理 / Mend 修补

Delay → Postpone 延迟 / Lag 落后

Accident → Crash 事故 / Mishap 意外

乡村一隅

Village → Hamlet 村庄 / Settlement 定居点

Countryside → Rural 乡村的 / Rustic 乡下的

Peaceful → Calm 宁静的 / Serene 安详的

Nature → Scenery 风光 / Landscape 风景

Visit → Tour 游览 / Explore 探索

退货

Return → Give back 归还 / Restore 退回

Refund → Reimburse 退款 / Repay 偿还

Buy → Purchase 购买 / Acquire 获得

Exchange → Swap 交换 / Trade 交易

Defect → Flaw 缺陷 / Fault 缺点

【三、P 老题】

以下每个话题下给出几组常用词汇，均为口语中常见的简单表达。

Bikes
Bike → Cycle 自行车 / Two-wheeler 双轮车

Ride → Cycle 骑行 / Cruise 兜风

Helmet → Headgear 头盔 / Protective gear 防护装备

Path → Route 路径 / Track 小路

Pedal → Push 踩 / Rotate 踩动

Coins



Coin → Money 硬币 / Cash 货币

Pocket → Pouch 小包 / Satchel 小袋

Spare change → Loose coins 零钱 / Small money 小额零钱

Collect → Gather 收集 / Accumulate 积攒

Currency → Money 货币 / Legal tender 法定货币

Roads and Streets
Road → Street 道路 / Route 路线

Street → Avenue 街道 / Lane 巷子

Cross → Traverse 横过 / Walk through 穿过

Traffic → Vehicles 交通 / Congestion 拥堵

Signal → Light 红绿灯 / Sign 标志

Laughing
Laugh → Giggle 咯咯笑 / Chuckle 轻笑

Funny → Amusing 滑稽的 / Comical 可笑的

Joke → Quip 玩笑 / Jest 笑话

Smile → Grin 微笑 / Beam 喜笑颜开

Cheer → Rejoice 欢欣 / Exult 兴高采烈

Fishing
Fish → Catch 鱼 / Seafood 海鲜

Bait → Lure 诱饵 / Attractant 吸引物

Rod → Pole 钓竿 / Fishing pole 钓竿

Catch → Net 捕获 / Snare 捕捉

Reel → Spool 卷线器 / Wind-up 捻线器

Teachers
Teacher → Educator 教师 / Instructor 指导员

Tutor → Mentor 导师 / Coach 教练

Lesson → Class 课程 / Instruction 讲课

Explain → Clarify 解释 / Elucidate 阐明

Educate → Teach 教导 / Instruct 指示

Place of Work/Study
Study → Learn 学习 / Read 阅读

Work → Labor 工作 / Job 职位

Office → Workplace 办公室 / Station 工作场所

Library → Bookroom 图书馆 / Study hall 自习室

Campus → School grounds 校园 / University grounds 校区

Perfume
Perfume → Fragrance 香水 / Scent 香味

Scent → Aroma 香气 / Odor 气味



Aroma → Smell 香气 / Odor 气味

Spray → Mist 喷雾 / Aerosol 雾剂

Fragrance → Perfume 香水 / Bouquet 香氛

Good View
View → Scene 风景 / Vista 远景

Scenery → Landscape 景色 / Viewpoint 观景

Landscape → Scenery 自然风光 / Terrain 地形

Sight → Scene 景象 / Spectacle 壮观景象

Panorama → Wide view 全景 / Sweep 广阔景色

Teamwork
Team → Group 团队 / Squad 小组

Group → Cluster 群体 / Assembly 集体

Collaborate → Cooperate 合作 / Work together 携手合作

Cooperate → Collaborate 配合 / Assist 协助

Unity → Togetherness 团结 / Harmony 和谐

Meet New Friends/People
Friend → Pal 朋友 / Buddy 好友

Meet → Encounter 遇见 / Connect 结识

Socialize → Mingle 交际 / Interact 互动

Chat → Talk 闲聊 / Converse 交谈

Network → Connect 联络 / Link 联系

Swimming
Swim → Paddle 游泳 / Float 漂浮

Water → HO 水 / Liquid 液体

Pool → Swimming pool 泳池 / Basin 水池

Stroke → (Swim stroke) 蛙泳（划水方式） / Freestyle 自由泳

Dive → Plunge 跳水 / Submerge 沉入

Mobile Phone
Phone → Mobile 手机 / Cellphone 移动电话

Call → Ring 打电话 / Buzz 呼叫

Text → Message 短信 / SMS 短信

Message → Note 信息 / Communication 通讯

Smartphone → Mobile phone 智能手机 / Cell phone 手机

Evening Time
Evening → Dusk 黄昏 / Night 晚间

Night → Evening 夜晚 / Dark 黑夜

Dusk → Twilight 暮色 / Sundown 日落

Relax → Unwind 放松 / Rest 休息



Unwind → Relax 放松 / Decompress 缓解

Feeling Bored
Bored → Uninterested 无聊的 / Tired of 厌倦的

Dull → Boring 乏味的 / Monotonous 单调的

Tedious → Boring 冗长的 / Wearisome 令人疲倦的

Weary → Tired 疲惫的 / Exhausted 累坏的

Lethargic → Sluggish 昏昏欲睡的 / Inert 无精打采的

Computers
Computer → PC 电脑 / Machine 机器

Laptop → Notebook 笔记本电脑 / Portable computer 便携电脑

Screen → Monitor 显示屏 / Display 显示器

Keyboard → Typewriter 键盘 / Input device 输入设备

Internet → Web 网络 / Online 线上

Talents
Talent → Ability 才能 / Skill 技能

Skill → Talent 本领 / Expertise 专长

Ability → Capability 能力 / Competence 资格

Gift → Endowment 天赋 / Flair 天分

Knack → Aptitude 天资 / Bent 天赋

Mirrors
Mirror → Reflector 镜子 / Glass 镜面

Reflection → Image 倒影 / Likeness 相似

Glass → Mirror glass 镜面玻璃 / Pane 玻璃片

Look → Glance 一瞥 / Gaze 目光

Vanity → Self-image 自恋（较书面） / Narcissism 自我陶醉

Old Buildings
Old → Aged 年老的 / Antique 古老的

Ancient → Old 古老的 / Historic 历史的

Building → Structure 建筑 / Edifice 大厦

Heritage → Legacy 遗产 / Tradition 传统

Renovate → Restore 翻新 / Revamp 改造

Lost and Found
Lost → Missing 丢失的 / Gone 失去的

Found → Discovered 找到的 / Retrieved 找回的

Missing → Lost 遗失的 / Absent 缺席的

Locate → Find 定位 / Spot 发现

Recover → Retrieve 取回 / Regain 恢复



Emails
Email → Message 电子邮件 / Mail 邮件

Send → Dispatch 发送 / Transmit 传送

Inbox → Mailbox 信箱 / Received box 收件箱

Attach → Enclose 附件 / Include 附上

Reply → Respond 回复 / Answer 回答

Dreams
Dream → Vision 梦想 / Fantasy 幻想

Hope → Wish 希望 / Aspiration 志向

Aspiration → Dream 志向 / Ambition 雄心

Vision → Image 幻想 / Imagination 想象

Goal → Aim 目标 / Objective 目的

Advertisement
Ad → Commercial 广告 / Promo 促销

Commercial → Ad 广告 / Spot 广告片

Promo → Promotion 促销 / Advertisement 广告

Notice → Announcement 通告 / Bulletin 公告

Slogan → Tagline 口号 / Motto 格言

Taking Photos
Photo → Picture 照片 / Snap 拍摄

Picture → Image 图像 / Shot 拍摄

Snapshot → Photo 照片 / Instant shot 快照

Shoot → Capture 拍摄 / Click 拍照

Camera → Device 相机 / Shooter 拍照机

Cars
Car → Auto 汽车 / Vehicle 车辆

Ride → Drive 驾驶 / Cruise 兜风

Drive → Operate 驾驶 / Steer 掌舵

Model → Type 型号 / Version 版本

Road → Highway 公路 / Route 路线

Street Market
Market → Bazaar 集市 / Fair 市场

Stall → Booth 小摊 / Stand 摊位

Vendor → Seller 卖家 / Merchant 商人

Bargain → Deal 讨价还价 / Discount 折扣

Shop → Store 商店 / Outlet 店铺

Websites
Website → Site 网址 / Webpage 网页



Page → Site 页面 / Portal 门户

Online → Digital 在线的 / Internet-based 网络的

Portal → Gateway 门户 / Access point 入口

Blog → Weblog 博客 / Journal 日志

Watch
Watch → Timepiece 钟表 / Wristwatch 手表

Clock → Timekeeper 时钟 / Chronometer 计时器

Wristwatch → Watch 手表 / Strapwatch 带表

Time → Hour 时间 / Moment 时刻

Tick → Beat 走时 / Signal 走秒

Time Management
Time → Hour 时间 / Moment 时刻

Schedule → Timetable 时间表 / Agenda 日程

Plan → Organize 计划 / Arrange 安排

Organize → Arrange 整理 / Systematize 系统化

Priority → Order 优先 / Preference 首选

Books and Reading Habits
Book → Volume 书籍 / Publication 出版物

Read → Peruse 阅读 / Browse 浏览

Novel → Fiction 小说 / Story 故事

Library → Bookroom 图书馆 / Archive 档案馆

Habit → Routine 习惯 / Custom 习俗

Collecting Things
Collect → Gather 收集 / Accumulate 积攒

Keep → Store 保留 / Retain 保持

Treasure → Cherish 珍藏 / Value 珍视

Item → Thing 东西 / Object 物品

Memory → Memento 纪念品 / Souvenir 纪念物

Sitting Down
Sit → Rest 坐下 / Perch 落座

Rest → Relax 休息 / Recline 躺下

Seat → Chair 椅子 / Bench 长椅

Lounge → Recline 躺着 / Sprawl 躺开

Settle → Sit down 就座 / Arrive 定位

Friends
Friend → Buddy 朋友 / Pal 伙伴

Buddy → Mate 伙伴 / Companion 同伴

Pal → Friend 朋友 / Chum 同伴



Mate → Friend 伙伴 / Partner 搭档

Companion → Friend 伴侣 / Comrade 同志

Art/Drawing
Art → Craft 艺术 / Drawing 绘画

Draw → Sketch 素描 / Illustrate 描绘

Sketch → Draw 素描 / Outline 概图

Paint → Color 上色 / Decorate 装饰

Design → Create 设计 / Plan 规划

Sports Programs
Sport → Game 运动 / Activity 运动

Game → Match 比赛 / Play 竞技

Exercise → Workout 锻炼 / Training 训练

Competition → Contest 比赛 / Event 活动

Team → Squad 队伍 / Group 集体

Hobby
Hobby → Pastime 爱好 / Interest 兴趣

Pastime → Hobby 消遣 / Recreation 娱乐

Leisure → Free time 空闲 / Relaxation 休闲

Interest → Hobby 兴趣 / Pursuit 追求

Activity → Pastime 活动 / Recreation 娱乐

Sharing
Share → Divide 分担 / Distribute 分配

Give → Offer 给予 / Donate 捐赠

Distribute → Allocate 分发 / Dispense 分派

Portion → Share 份额 / Slice 部分

Contribute → Provide 捐献 / Supply 供应

Language
Language → Tongue 语言 / Speech 言语

Speak → Talk 说话 / Converse 交谈

Learn → Study 学习 / Acquire 获得

Communicate → Converse 交流 / Interact 互动

Dialect → Vernacular 方言 / Idiom 习语

Pen & Pencil
Pen → Marker 笔 / Ballpoint 钢笔

Pencil → Stylus 铅笔 / Crayon 彩色铅笔

Write → Scribble 写 / Jot 记

Note → Remark 笔记 / Message 笺子

Draw → Sketch 绘图 / Doodle 涂鸦



Happy Things
Happy → Joyful 快乐 / Cheerful 愉快

Joy → Pleasure 喜悦 / Delight 欢喜

Cheerful → Bright 明朗 / Merry 欢乐

Pleasure → Enjoyment 愉快 / Satisfaction 满足

Delight → Bliss 欢喜 / Joy 幸福

T-shirt
T-shirt → Tee 衫 / Casual shirt 休闲衫

Tee → T-shirt 衫 / Top 上衣

Shirt → Top 衬衫 / Blouse 女衬衫

Casual → Informal 休闲的 / Relaxed 悠闲的

Wear → Don 穿着 / Put on 穿上

Number
Number → Digit 数字 / Figure 数字

Digit → Number 数位 / Numeral 数字

Figure → Number 数字 / Total 总数

Count → Tally 数数 / Enumerate 列举

Numeral → Figure 数字 / Symbol 符号

Relax
Relax → Unwind 放松 / Chill 休息

Unwind → Relax 放松 / Decompress 缓解

Rest → Repose 休息 / Break 休憩

Calm → Peaceful 平静 / Serene 安详

Ease → Relax 放松 / Soften 变柔和

Breakfast
Breakfast → Morning meal 早餐 / Brunch 早午餐

Meal → Dish 一餐 / Food 食物

Morning → Dawn 早晨 / AM 上午

Food → Edibles 食物 / Nourishment 营养

Cereal → Grain 谷物 / Oats 燕麦

Internet
Internet → Web 网络 / Online 线上

Web → Internet 网 / Cyberspace 网络空间

Online → Digital 线上 / Virtual 虚拟

Network → Net 网络 / Grid 网格

Digital → Electronic 数字的 / Virtual 虚拟的

News



News → Report 新闻 / Bulletin 公告

Report → News 报道 / Account 记录

Update → News 更新 / Refresh 刷新

Headline → Title 标题 / Banner 横幅

Information → Data 信息 / Details 细节

Science
Science → Study 学科 / Knowledge 知识

Experiment → Test 实验 / Trial 尝试

Research → Study 调研 / Inquiry 探究

Fact → Truth 事实 / Data 数据

Theory → Idea 理论 / Concept 概念

E-books and Paper Books
Book → Volume 书籍 / Tome 巨著

E-book → Digital book 电子书 / Online book 网络书籍

Paper → Print 纸质书 / Hardcopy 纸本

Read → Peruse 阅读 / Browse 浏览

Library → Collection 收藏 / Archive 档案

Daily Routine
Routine → Schedule 日程 / Habit 习惯

Daily → Everyday 日常 / Regular 定期

Habit → Custom 习惯 / Practice 习俗

Schedule → Timetable 时间表 / Plan 计划

Pattern → Cycle 循环 / Routine 规律

Doing Sports
Sport → Game 运动 / Activity 运动

Exercise → Workout 锻炼 / Training 训练

Play → Compete 比赛 / Engage 参与

Workout → Exercise 锻炼 / Session 训练

Train → Practice 训练 / Drill 训练

Exciting Activities
Exciting → Thrilling 令人兴奋的 / Stimulating 刺激的

Thrilling → Exhilarating 令人激动的 / Exciting 令人兴奋的

Fun → Enjoyable 有趣的 / Entertaining 娱乐的

Adventure → Excursion 冒险 / Quest 探险

Lively → Animated 生动的 / Vibrant 充满活力的

Schools and Workplaces
School → Institution 学校 / Academy 学院

Work → Job 工作 / Employment 就业



Office → Workplace 办公室 / Station 工作场所

Campus → Grounds 校园 / Premises 处所

Study → Learn 学习 / Attend 参加

Holidays
Holiday → Vacation 假期 / Break 休息

Vacation → Holiday 假日 / Leave 假期

Trip → Journey 旅行 / Tour 游览

Leisure → Free time 空闲 / Relaxation 休闲

Travel → Tour 旅游 / Journey 行程

Childhood Memory
Childhood → Youth 童年 / Early years 早年

Memory → Reminiscence 回忆 / Recollection 记忆

Past → History 过去 / Former 以前的

Nostalgia → Longing 怀旧 / Sentimentality 眷恋

Reminisce → Recall 回忆 / Remember 记起

Morning Routines
Morning → Dawn 早晨 / AM 上午

Routine → Habit 习惯 / Schedule 日程

Wake → Rise 起床 / Get up 起来

Start → Begin 开始 / Commence 开始

Breakfast → Morning meal 早餐 / Brunch 早午餐

Staying at Home
Home → House 住所 / Residence 住宅

Stay → Remain 停留 / Lodge 逗留

Relax → Unwind 放松 / Chill 休息

Indoors → Inside 室内 / In-house 内部

Cozy → Comfortable 舒适的 / Snug 温暖的

Challenges
Challenge → Trial 挑战 / Test 考验

Difficulty → Hardship 困难 / Problem 问题

Obstacle → Barrier 障碍 / Hindrance 阻碍

Test → Trial 考验 / Challenge 挑战

Struggle → Effort 挣扎 / Strive 努力

Plants
Plant → Flora 植物 / Greenery 绿植

Flower → Blossom 花朵 / Bloom 开花

Tree → Sapling 树苗 / Timber 木材

Garden → Yard 庭院 / Plot 小园



Green → Verdant 绿意盎然的 / Lush 茂盛的

Social Media
Social media → Social networks 社交媒体 / Online platforms 网络平台

Post → Publish 发帖 / Share 分享

Like → Enjoy 喜欢 / Appreciate 欣赏

Follow → Subscribe 关注 / Track 跟踪

Comment → Remark 评论 / Feedback 反馈

Films/Cinemas
Film → Movie 电影 / Flick 影片

Movie → Film 影片 / Picture 影片

Cinema → Theater 电影院 / Screenland 影城

Watch → View 观看 / See 看

Actor → Star 演员 / Performer 表演者

Music/Musical Instruments
Music → Song 音乐 / Melody 曲调

Song → Tune 歌曲 / Track 曲目

Instrument → Tool 乐器 / Device 设备

Play → Perform 演奏 / Strum 弹奏

Band → Group 乐队 / Ensemble 合奏团

The City You Live In
City → Town 城市 / Metropolis 大都市

Town → Small city 小城 / Borough 区域

Urban → City 化的 城市的 / Metropolitan 大都市的

Area → Region 地区 / Zone 区域

Place → Locale 地点 / Spot 地方

Weekends
Weekend → Break 周末 / Holiday 假日

Break → Pause 休息 / Interval 间隔

Rest → Relax 放松 / Recess 休息

Leisure → Free time 空闲 / Recreation 娱乐

Off days → Rest days 休息日 / Days off 假日

【四、万年老题】

A Work or Studies
Subject → Course 课程 / Field 领域

Major → Discipline 专业 / Concentration 主修

Study → Learn 学习 / Research 研究



Work → Job 工作 / Career 职业

Career → Profession 职业 / Vocation 行业

Degree → Diploma 学位 / Qualification 资格

University → College 大学 / Institution 机构

Class → Lesson 课程 / Session 课堂

Assignment → Task 作业 / Project 项目

Exam → Test 考试 / Assessment 测验

Lecture → Talk 演讲 / Presentation 陈述

Seminar → Workshop 研讨会 / Forum 讨论会

Internship → Apprenticeship 实习 / Work placement 实习岗位

Scholarship → Grant 奖学金 / Fellowship 资助

Professor → Teacher 教授 / Lecturer 讲师

Syllabus → Outline 大纲 / Curriculum 课程体系

Certification → Credential 证书 / Qualification 资格

Thesis → Dissertation 论文 / Research paper 研究报告

Tutorial → Session 辅导课 / Coaching 讲解

Campus → Grounds 校园 / Premises 校区

B Home/Accommodation
Home → House 住所 / Residence 住宅

Apartment → Flat 公寓 / Condo 公寓

Room → Space 房间 / Area 区域

Kitchen → Cooking area 厨房 / Galley 厨房

Living room → Lounge 客厅 / Sitting room 起居室

Bedroom → Sleep room 卧室 / Bedchamber 寝室

Bathroom → Washroom 卫生间 / Restroom 厕所

Balcony → Veranda 阳台 / Terrace 露台

Garden → Yard 庭院 / Lawn 草坪

Furnishings → Furniture 家具 / Decor 装饰

Rent → Lease 租赁 / Hire 租用

Owner → Landlord 房东 / Proprietor 所有者

Neighbor → Resident 邻居 / Inhabitant 居民

Apartment building → Block 公寓楼 / Complex 小区

Maintenance → Upkeep 保养 / Care 维护

Security → Safety 安全 / Protection 保护

Area → Neighborhood 邻里 / Locale 地点

Utilities → Services 设施 / Amenities 便利设施

Decoration → Furnishing 装饰 / Ornamentation 装潢

Comfortable → Cozy 舒适的 / Snug 温暖的

C Hometown
Hometown → Native town 故乡 / Birthplace 出生地



Village → Hamlet 村庄 / Settlement 定居点

City → Urban 城市 / Metropolis 大都市

Town → Small town 小城 / Borough 区域

Community → Locality 社区 / Neighborhood 邻里

Tradition → Culture 传统 / Heritage 遗产

History → Past 历史 / Background 背景

Landmark → Monument 地标 / Icon 标志

Festival → Celebration 节日 / Fair 盛会

Local → Native 当地的 / Indigenous 土著的

Scenery → Landscape 风景 / View 景色

Custom → Tradition 风俗 / Practice 习俗

Culture → Lifestyle 生活方式 / Ethos 精神风貌

Roots → Origins 根源 / Heritage 根基

Neighborhood → Area 邻里 / District 区域

Folk → People 民风 / Community 社区

Market → Bazaar 市集 / Fair 市场

Local food → Cuisine 当地菜肴 / Speciality 特色菜

Environment → Surroundings 环境 / Setting 背景

Memory → Reminiscence 回忆 / Nostalgia 怀旧

D The Area You Live In
Area → Region 地区 / Zone 区域

Neighborhood → Community 邻里 / Vicinity 附近

District → Quarter 地区 / Sector 部分

Region → Territory 领土 / Locale 地域

Suburb → Outskirts 郊区 / Residential area 住宅区

Urban → City 化的 城市的 / Metropolitan 大都市的

Rural → Countryside 乡村的 / Rustic 乡下的

Locale → Area 地点 / Setting 背景

Block → Section 街区 / Segment 部分

Street → Road 街道 / Avenue 大道

Plaza → Square 广场 / Forum 市场

Commercial → Business 商业的 / Trade 商贸的

Residential → Housing 居住的 / Domestic 家庭的

Facilities → Amenities 设施 / Services 服务

Infrastructure → System 基础设施 / Framework 构架

Public → Open 公开的 / Community 公共的

Transport → Transit 交通 / Conveyance 运输

Safety → Security 安全 / Protection 保护

Greenery → Vegetation 绿化 / Foliage 植被

Environment → Surroundings 环境 / Setting 背景



观点陈述:
"I suppose"
"From my perspective"
"What I've noticed is"

回忆描述:
"I remember when"
"Back in my childhood"
"There was this one time"

假设场景:
"If I had to choose"
"Imagine a situation where"
"Let's say"

以下是按照要求扩充的个相关子目录，涵盖观点陈述、回忆描述和假设场景的表达方式：

观点陈述 (个)
个人观点

- "In my opinion"
- "As far as I'm concerned"
- "The way I see it"

普遍认知

- "It's commonly believed that"
- "Generally speaking"
- "Most people would agree that"

强调观点

- "What's particularly interesting is"
- "What strikes me most is"
- "The crucial point is"

对比观点

- "While some may argue, I believe"
- "Contrary to popular belief"
- "Unlike many people think"

条件观点

- "Provided that, I would say"
- "On the condition that"
- "Assuming that"



渐进观点

- "Not only, but also"
- "What's more"
- "Furthermore"

总结观点

- "All things considered"
- "Taking everything into account"
- "In conclusion"

让步观点

- "Although it's true that"
- "Even though"
- "Despite the fact that"

回忆描述 (个)
清晰回忆

- "I can vividly recall"
- "It's still fresh in my memory that"
- "One incident that stands out is"

模糊回忆

- "If my memory serves me right"
- "As far as I can remember"
- "To the best of my recollection"

情感回忆

- "What still touches me deeply is"
- "I'll never forget how"
- "It warms my heart to remember"

成长回忆

- "Looking back on my teenage years"
- "During my formative years"
- "As I was growing up"

学习回忆

- "My earliest memory of learning"
- "I distinctly remember studying"
- "One educational experience that shaped me was"

特殊时刻

- "On that particular occasion"



- "At that critical moment"
- "During that unforgettable event"

假设场景 (个)
未来假设

- "If I were to predict"
- "Should the situation arise where"
- "In the event that"

虚拟假设

- "If I had the opportunity"
- "Were I in that position"
- "Supposing I could"

条件假设

- "Given the chance"
- "On the assumption that"
- "Provided the circumstances allow"

极端假设

- "In the worst-case scenario"
- "Should the unthinkable happen"
- "If all else fails"

理想假设

- "In an ideal world"
- "If everything went according to plan"
- "Assuming perfect conditions"

对比假设

- "Whereas in normal circumstances"
- "Unlike what might be expected"
- "Contrary to what one might assume"

使用示例

观点陈述:
"From my perspective, learning a new language is not just about grammar rules What's
particularly interesting is how it opens doors to understanding different cultures"

回忆描述:
"I can vividly recall my first day at university It's still fresh in my memory how nervous yet excited
I was, standing in front of the main building with my new backpack"

假设场景:



"Imagine a situation where everyone could speak multiple languages In such a world, cultural
barriers would diminish, and international cooperation would flourish"

一、观点陈述 (Expressing Opinions)

I suppose → I believe that 我认为 / I think that 我觉得

From my perspective → In my view 从我的角度看 / As I see it 就我看来

What I've noticed is → I've observed that 我注意到 / I've found that 我发现

I believe that → I hold that 我坚信 / I feel that 我感觉

In my opinion → To my mind 在我看来 / Personally, I think 就我个人而言

As far as I'm concerned → In my book 在我看来 / For me 来说

To my mind → In my opinion 在我心里 / As I see it 就我看来

It seems to me that → I reckon that 我认为 / It appears that 看起来

I reckon → I figure 我猜想 / I assume 我假定

I think that → I feel that 我觉得 / I consider that 我认为

Personally, I feel → Personally, I believe 就我个人来说 / In my view 在我看来

My view is that → I maintain that 我的观点是 / I stand by my opinion 我的立场是

I would say → I might say 我想说 / I'd suggest 我会建议

If you ask me → In my estimation 如果你问我 / From where I stand 从我的角度看

As I see it → From what I see 就我所见 / Based on my view 根据我的看法

I consider that → I deem that 我认为 / I judge that 我评估

I am of the opinion that → I hold the view that 我持这种看法 / I opine that 我认为

In my view → From my standpoint 从我的角度 / To me personally 对我来说

Frankly speaking → Honestly speaking 坦白说 / To be honest 说实话

To be honest → Honestly speaking 坦白说 / Truthfully speaking 真实地说

二、回忆描述 (Recounting Memories)

I remember when → I recall when 我记得… / I vividly remember 当时我清楚地记得…

Back in my childhood → In my early years 在我早年 / When I was young 在我年轻时

There was this one time → I once experienced 曾经有一次 / Once upon a time 有一次

I recall a time when → I remember a moment when 我记得有一次 / I reminisce about the
time when 我回忆起那时

Once upon a time → In the past 从前 / Long ago 很久以前

I vividly remember → I clearly remember 我清楚地记得 / I can still picture vividly 当时我仍

能生动地想象

I can still recall → I still remember 我仍然记得 / I haven't forgotten that 我没有忘记

In my early years → When I was a child 当我还是孩子时 / In my youth 在我的青春期

I used to → I once used to 我曾经 / I was accustomed to 我曾习惯于

I have a memory of → I hold a memory of 我记得 / I recall clearly 我清楚地回忆起

Long ago, → Many years ago 多年前 / Back then 当时

When I was younger → In my younger days 在我年轻的时候 / In my childhood 在我的童年



I reminisce about → I remember fondly 我温馨地回忆 / I think back to 我回想

I have fond memories of → I cherish the memories of 我珍视那些回忆 / I recall with warmth
我温暖地记起

Looking back, I recall → In retrospect, I remember 回顾过去，我记得 / Reflecting on the past,
I remember 回想过去，我记起

I clearly remember → I distinctly recall 我清楚地记得 / I have a clear memory of 我对…记

忆犹新

During my childhood, → In my younger days, 当我还是孩子时 / Back when I was young 那

时我年轻

In my younger days, → When I was young, 在我年轻时 / During my youth, 在我的青春时期

Once, I experienced → There was a time when 我曾经经历过 / I once went through 那时我

经历过

I remember vividly that → I recall clearly that 我清晰地记得 / I can vividly recall that 我能生

动地记得

三、假设场景 (Presenting Hypothetical Scenarios)

If I had to choose → If I were to choose 如果我必须选择 / Should I choose 要是我选择

Imagine a situation where → Picture a scenario where 想象一下… / Envision a case where
设想一种情况

Let's say → Suppose that 假设 / For instance, 比如说

Suppose that → Imagine that 设想 / Let's assume that 假定

If I were to imagine → If I were to envision 如果我设想 / If I could imagine 要是我能想象

Picture a scenario where → Visualize a case where 想象一下情况 / Envision a scenario
where 设想一种场景

Assuming that → Presuming that 假定 / Given that 考虑到

For instance, → For example, 举个例子 / To illustrate, 例如

If I were in that situation → If I found myself in that scenario 如果我处于那种情况 / Were I
in that case 假如我在那种情况下

Consider a case where → Think of a scenario where 想想一种情况 / Reflect on a scenario
where 思考一种情景

Let's imagine → Let's envision 让我们设想 / Consider this 试想一下

Hypothetically speaking, → In a hypothetical situation 假设性地说 / Theoretically speaking
理论上来说

Imagine if → Picture if 想象一下 / Consider if 设想如果

Presume that → Assume that 假定 / Suppose that 设想

Suppose I were → Imagine I were 假如我是 / Let's assume I was 让我们假设我曾是

What if → How about if 如果 / Suppose what if 假如怎样

If I were forced to choose → If I had no choice 要是我别无选择 / Were I forced to choose 如

果我被迫选择

Let us assume → Let's assume 让我们假设 / Suppose we assume 假如我们假设

Envision a case where → Imagine a case where 想象一下一个情况 / Picture a case where
想象一种情况



If circumstances were such that → If conditions were like that 要是情况是那样 / Suppose
circumstances were such 假设情况如此


